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1 «Interactive Dashboard» report  
Dashboard is a type of a report with the following components: “Pivot”, “Grid”, “Chart”, 

“Scatter Chart”, “Pies”, “Gauges”, “Cards”, “Treemap”, “Filter Elements”, “Images”, “Text Box”, 

“Group”.  

Upon starting a program, a dashboard-type report appears in reports tree.  

 

Note: this one must be created by administrator. 
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When the report type «Interactive Dashboard» is opened, the following window appears: 

 
 

The list of all the reports will be shown on the left: 

• Admin’s – reports created by administrator 

• My – owner’s reports 

• Shared – reports shared with other users. 
 

Dashboard elements themselves are shown on the right. 

As we can see, there is no My Dashboards list. Let us create an «Interactive Dashboard». 
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1.1 How to create an «Interactive Dashboard» 

There are several ways to create an «Interactive Dashboard»: 

 

Way 1. In a “Dashboard” menu choose “Add”. 

Way 2. Click “Add new Dashboard” button in a toolbar. 

A window appears, where you should write a name for the «Interactive Dashboard»: 
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As a result, a dashboard designer window will appear: 
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1.2 Basic dashboard navigation  

We will take a previously-created dashboard as an example of navigation: 

 

A toolbar with dashboard elements is located in the upper part of the window: 

• Pivot 

• Grid 

• Chart 

• Scatter Chart 

• Pies 

• Gauges 

• Cards 

• Treemap 

• Range Filter 

• Filter Elements 

• Images 

• Text Box 

• Group 

The following functionality is available for dashboard elements: 

• Title 

• Currency 

• Edit Colors 

• Parameters 
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In the left part of the window there is a data source (OLAP DB) with respective hierarchies, 

dimensions. One dashboard can have several data sources: 

  

Note: In order for a dashboard to have several data sources you should contact an 

administrator. 

 

1.3 Dashboard elements 

Dashboard designer window consists of following elements: 

� Pivot 

� Grid 

� Chart 

� Scatter Chart 

� Pies 

� Gauges 

� Cards 

� Treemap 

� Ghoropleth Map 

� Geo Point Maps 

� Range Filter 

� Filter Elements 

� Images 

� Text Box 

� Group 
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1.4 Create, delete, convert to, duplicate and other possibilities 

 Create 1.4.1

In order to create a new dashboard element, you need to click a respective icon in dashboard 

designer window: 

 

 Delete 1.4.2

In order to delete a dashboard element, you need to click an icon in a toolbar: 

 

In order to quickly delete all the filled fields of one of a dashboard element (grid, chart, etc.) 

you need to click an icon: 

 

 Convert To 1.4.3

It is possible to modify one dashboard element into another by choosing a respective item in 

the toolbar: 
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 Duplicate 1.4.4

In order to duplicate an existing dashboard element, you need to click an icon in a toolbar: 

 

 

 Transpose 1.4.5

For such dashboard element as pivot, chart, scatter chart, diagram there is a possibility to 

transpose lines and columns for a grid, parameters and sets of diagrams, axes “X” and “Y” of a 

chart: 

 

1.5 Pivot 

Pivot is a multidimensional array of data.  

Let us take a “Pivot” that shows volume of sales and profit by product category in each 

country as an example. For this we choose “Pivot” in the toolbar, in the value field we will have  

“Reseller Sales Amount” and “Reseller Gross Profit” measures, on the rows of the “Country” and 

“Category” hierarchy. The pivot will look the following: 
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 Expand/minimize  1.5.1

By clicking  and  buttons, you can expand/minimize data to needed extent. 

 Layout type 1.5.2

The Pivot layout can be: 

• Compact 

 

• Tabular 
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Use the “Layout” button in the “Design” ribbon tab to change the Pivot layout: 

 

 Totals 1.5.3

You can control the visibility of totals and grand totals for the entire Pivot dashboard item: 

 

 Initial state 1.5.4

“Initial State” of a pivot may be the following: 

 

• Expand Column Groups 

• Expand Row Groups 
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By ticking this functionality box, we will always see an expanded level: 

 

 Grand Totals 1.5.5

In the pivot table, you can enable or disable grand totals: 
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 Totals 1.5.6

For the pivot of the tabular type (s. 1.5.2), you can enable and disable totals for the highest 

level: 

 

For instance, the image below displays the Pivot dashboard item with the disabled row 

totals: 

  
Moreover, you can control the visibility of totals for individual dimensions/measures by 

using the data item's context menu (“Show Totals” and “Show Grand Totals” options): 
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 Totals Position 1.5.7

If necessary, you can change the Pivot dashboard item’s totals/grand totals position: 

            

     

 Values Position 1.5.8

The Pivot dashboard item allows you to control the position of headers used to arrange 

summary values corresponding to different measures: 
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 Filter 1.5.9

In the tab Data it is possible to create a quick filter for the whole pivot. It could be done in 

two ways: 

Way 1. Click “Change filter” button in “Data” tab in dashboard design window. 

 

Way 2. Open context menu (click the right mouse button) at any place of a pivot. 
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Only those hierarchies, which are present in the report, may be a filter for a Pivot: 

 

Let us display, for instance, values “Reseller Sales Amount” and “Reseller Gross Profit” for 

product categories “Bikes” and “Clothing”: 
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Pivot will look the following: 

 

 Format 1.5.10

In order to change the format of a calculating value, you need to open context menu: 
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A numeric-format form will open: 

 

The form contains following fields: 

� Format type – format type may be: 

 

� Unit – Date and currency format type may have the following presentation: 

 

� Precision – number of symbols after comma; 

� Currency – currency will use toolbar parameters by default (interface language), or 

you could choose specific currency type from a dropdown list; 

� Culture – reference culture for a region should be specified; 

� Include group separator – turn a space on/off. 
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 Formatting 1.5.11

Upon opening value context menu, it is possible to create a formatting rule (highlighting): 

 

In abstract 1.18 a process of creation of formatting rules is described in more details. 

 Title 1.5.12

Before saving a created pivot let us rename its title. 

This may be done in two ways: 

Way 1. In “Design” tab press “Edit names” icon. 
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Way 2. Open context menu in a pivot (click the right mouse button) and choose “Edit 

names” from the list. 

 

In an appeared form enter the following data: 

 

Now a pivot title looks the following: 
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If needed, title may not be displayed: 

 

Before closing a pivot should be saved by clicking a “Save” icon in the toolbar: 

 

Or an application will offer to save a pivot itself: 
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A new dashboard element — a pivot Reseller will be the result: 

 

For next dashboard element editing it is needed to click an “Edit” icon in the toolbar: 
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 Export 1.5.13

If needed you can export a pivot into PDF, Excel or a picture format by clicking the right 

mouse button in a pivot: 
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� Export To PDF 

The following options are available when exporting the Pivot dashboard item to a PDF: 

 

• Page Layout – page orientation; 

• Size – page size; 

• Show Title – to display or not to display page title; 

• Title – name of page title; 

• Print Headers on Every Page – to print or not to print a title on every page; 

• Scale Mode – zoom mode; 

• Scale Factor – specifies the scale factor (in fractions of 1) by which a 

dashboard is scaled; 

• Auto Fit Page Count – specifies the number of horizontal/vertical pages 

spanning the total width/height of a dashboard; 

• Include Filters / Parameters – allows you to include master filter values / 

parameter values to the exported document; 

• Position – specifies the position of the master filter and parameter values in 

the exported document. 
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� Export To Excel 

While exporting into Excel the following options are available: 

 

• Excel Format – xlsx, xls, csv formats; 

• Separator – specifies the string used to separate values in the exported CSV 

document; 

• Include Filters / Parameters – allows you to include master filter values / 

parameter values to the exported document; 

• Position – specifies the position of the master filter and parameter values in 

the exported document. 

 

� Export to Image. 

            While exporting into a picture format the following options are available: 

  

• Image Format – PNG, JPEG, GIF formats; 

• Show Title – specifies the image format in which the dashboard item is 

exported; 

• Title – name of a pivot title; 

• Resolution(dpi) – specifies the resolution (in dpi) used to export a dashboard; 

• Include Filters / Parameters – allows you to include master filter values / 

parameter values to the exported document. 
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1.6 Grid 

Let us add a new element called Grid to an already-existing dashboard.  

For this we first click an “Edit” icon on a dashboard toolbar, and then in a dashboard design 

window click a “Grid” button: 

 

Let us look at the grid, which will display the results of sales by product categories. In the 

column move a “Category dimension and a “Reseller Sales Amount” measure: 

 

 Column type 1.6.1

Columns in a grid may be of the following type: 
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� Dimension – a column shows DB dimension; 

� Measure – a column shows measure value; 

� Delta – a column, which shows a delta of two measures, where one is an actual and 

the other – a target; 

� Sparkline – a chart, which shown a measure value in a given interval (date and time); 

� Hyperlink – a hyperlink column allows you to display hyperlinks in the Grid 

dashboard item; 

� Auto – a column type is defined automatically. 

 Delta column 1.6.2

Let us create a column of a “Delta” type. Choose the type and click an «ОК» button: 
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In a column field two new fields – “Actual” and “Target” appear. Let’s choose a “Reseller 

Internet Quantity” measure for real values (actual), and a “Reseller Order Quantity” measure will be 

a target. We will get a new column, which will show a delta value and its indicator: 

 

A delta value type may be the following: 

 

• Actual value – an actual measure value; 

• Absolute variation – difference between an actual and a target; 

• Percent variation – percent of difference between an actual and a target; 

• Percent of target – percent of an actual and a target. 
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An indicator may have the following value: 

 

• Greater is good – «good» a target is achieved (an actual is bigger than a target); 

• Less is good – «bad» a goal is not achieved (an actual is less than a target); 

• Warning if greater – a target is bigger than an actual; 

• Warning if less – a target is less than an actual; 

• No indication – indication is not displayed. 

For the delta, you can set the threshold value, which will indicate the excess of the actual 

above the target. 
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The threshold can be of the following type: 

 

Let's get back to our grid and see if the target is achieved as a percentage. For this, let’s fill 

out the form as follows: 
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As a result, we will see a delta column in which all the values exceeding the target are 

highlighted with a green indicator, and the red values are those that have not reached a target: 

  

Obviously, the target was achieved only for “Accessories” category.  

The delta value can be displayed not only as text, but also as a diagram: 
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 Sparkline Column 1.6.3

Let's create a column of a “Sparkline” type. For this, let’s consider how the quantity of 

orders for product categories changed depending on the month of the year. For this, we will insert 

the “Reseller Order Count” measure in the columns and select the “Sparkline” column type: 

 

The following settings will be available in the opened form: 

� Show start/end values – species whether or not to display sparkline start/end values 

within a grid cell; 

� Sparkline view type: 

• Line 

• Area  

• Bar 

• Win/Loss – a column-type graph (of the same size) with a Win (maximum 

value) mark and a Loss (minimum value) mark. 

� Highlight min/max points  

� Highlight start/end points. 
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Fill out the form in the following way: 

 

Then in the “Sparkline” field, drag the “Month of Year” dimension. As a result, we get the 

following report: 
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The following data is displayed in the sparkline column: 

 

 Hyperlink column 1.6.4

A hyperlink column allows you to display hyperlinks in the Grid dashboard item. 

You can provide hyperlinks as a separate data column or they can be automatically created 

at run-time from any column using the specified URI pattern. 

1.6.4.1 Data Field Containing Uri Values 

For example, take the data source of type excel-table, which contains the following fields: 
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Now let's create a table and fill it with the following data: 

 

The Grid displays column values as clickable hyperlinks allowing you to navigate to the 

Wiki's pages: 

 

You can bind the display value and URI value to different data fields. Click the “New 

Column” data item placeholder: 
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and change its type to “Hyperlink”: 

 
Drag and drop the “OfficialName” field to the display value data item placeholder to display 

official country names. Drag and drop the “Link” field to the Uri data item placeholder to specify 

URIs. 

The Grid displays official country names with links obtained from the Link data source 

field: 
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1.6.4.2 URI 

In this case, a specified URI pattern is used to generate links. 

Create the following grid: 

 

Click the “Column Type” indicator button next to the “Name” data item and change its type 

to “Hyperlink”. Specify the URI Pattern option as follows:  https://en.wikipedia.org/wiki/{0} 

 

The {0} placeholder is replaced with the “Name” data item value. The links are generated 

for country names and displayed in the grid as illustrated in the following picture: 
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 Drill Down 1.6.5

Let's see what product subcategories in the “Accessories” category were of positive 

dynamics. For this, in the “Data” tab on the toolbar, click the “Drill Down” icon 

 

and in the grid itself, in the “Columns” field under the “Category” hierarchy, drag the 

“Subcategory” hierarchy: 

 

Now by clicking the “Accessories” product category, we will see all the product 

subcategories that it includes: 
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In order to get back to the initial grid view click a grid icon: 

 

 Additional grid properties 1.6.6

In a “Design” tab of a Grid dashboard element the following toolbar is available: 

 
� Horizontal Lines – show horizontal grid lines; 

� Vertical Lines – show vertical grid lines; 

� Banded Rows – banded rows are not supported when cell merging is enabled; 

 

� Merge Cells – merge adjacent cells with identical data (“Drill Down” has to be off); 

 

� Column – show column headers; 

� Word Wrap; 

� AutoFit to Contents; 

� AutoFit to Grid; 

� Manual – adjust the width of columns manually. 
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By clicking a grid title, the following functionality will be available: 

 

� Fit to Content – fit the column width to its content; 

� Fit Width – specify the column width and fix it; 

� Column Width – specify the fixed column width; 

� Add Format Rule – possibility to choose one of the formatting ways form a dropdown list 

(the process is described in more details in abstract 1.18); 

� Edit Rules – possibility to change the existing highlighting rules; 

� Clear Rules – deletion of all the highlighting rules; 

� Add Total – possibility to display: 

 

� Clear Totals– delete all summaries. 

Let's display the minimum and maximum value of the “Reseller Sales Amount” measure in 

our grid: 

 

 Export 1.6.7

A grid can be exported into PDF, Excel or a picture format. Way are described in 

abstract 1.5.13. 
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1.7 Chart 

To create a chart, you need to click a “Chart” icon in the dashboard designer window on the 

toolbar: 

 

As a result, a new dashboard element appears: 

 

The left item contains the following chart parameters: 

• Values – measure, data is displayed on the Y-axis; 

• Argument – dimension, data is displayed on the Х-axis; 

• Series – dimension, data that is used to create series. 

In the field on the right there will be a chart itself. 
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Let us create a chart, which will show the sales volume of product categories by year. 

Having filled in the fields as in the picture below, you will get the following chart: 

 

Let us change its type: 
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A window of the following view will open: 

 

The first tab “Series Type” allows redefining a chart type.  Among all the suggested options, 

let us choose “Full-Stacker Bar”: 
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A “Common Options” tab offers following possibilities: 

 

� Plot on secondary axis – data is displayed secondary axis 

� Ignore empty points – not to display zero values in a chart; 

� Show point markers - for a chart of an “Area” type point markers are displayed. 

 

We will not change anything here. 

 

In a “Point Label Options” tab, the following possibilities are available: 
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� Content: 

• Select All 

• Argument 

• Series Name  

• Percent 

� Overlapping mode: 

• Hide overlapping labels – hide overlapping labels; 

• None – display all the labels; 

• Reposition  overlapping labels – hide overlapping labels regime is off (all the 

labels without overlapping will be shown). 

� Orientation: 

• Default – labels are located horizontally; 

• Rotate to the Right – labels rotation for 90 degrees clockwise; 

• Rotate to the Left - labels rotation for 90 degrees counterclockwise. 

� Bar options: 

• Show for zero values – to display or not to display zero values; 

• Position – labels position either outside or inside (for Histograms and 

Bubbles). 

Fill out the following tab as shown below: 
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As a result, the report will have the following view: 

 

Let us add one more data panel: 
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To the existing chart, we add one more panel that displays the number of orders for all the 

same product categories by year. For this, drag the “Reseller Order Count” measure to the value 

bar, select the “Spline” type of the chart and set the following parameters on the remaining tabs: 

 

 

 

As a result, we will get the following chart: 
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 X/Y – Axis settings  1.7.1

The chart in the dashboard has two axes – “X” and “Y”. The “X”-axis is the axis of the 

arguments, and the “Y”-axis is the numerical axis of the measure value. The following options for 

chart are in the “Design” tab: 

 

� Rotate  - rotate the diagram at 90° 

� “Х”-Axis Settings 

� “Y”-Axis Settings 

Let us have a look at the settings for each axis. 

For “Х”-axis, the following parameters are available: 

 

� Reverse – display values in descending order; 

� Enable zooming  

� Show X-axis 

� Show title 

• Default text – dimension name 

• Custom text – text, entered by a user 

� Limit visible points – a number of visible point on an axis. 
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For “Y”-axis, the following parameters are available: 

 

� Always show zero level 

� Reverse – rotate an axis at 180° 

� Show grid lines – to display or not to display grid lines 

� Show axis – show/hide an axis  

� Show title – to display or not to display a title; 

• Default text – dimension name 

• Custom text – text, entered by a user 

� Logarithmic scale – to display or not to display a logarithmic scale. 

 Legend 1.7.2

To change the location of the legend, go to the “Design tab”: 

 
The following functionality will be available on the toolbar: 

� Show Legend – to display or not to display a legend; 

� Legend location: 
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 Series Type 1.7.3

You can change the type of the row on the toolbar in a “Design” tab. 

 

The following chart types are available in the drop-down list: 

 

 Edit Colors 1.7.4

You can change the color of the chart elements in two ways: 

Way 1. Click an “Edit Colors” icon in the “Design” tab toolbar: 

 
Way 2. Click the same icon in the toolbar of the dashboard designer window: 
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In the window that appeared, select the required element and set the color for it: 

  

 Drill Down 1.7.5

Such a function as Drill Down is possible for charts. It is described in abstract 1.6.5 in more 

details. 

 Export 1.7.6

Charts can be printed and exported into PDF, Excel or an image. Ways to do this are 

described in abstract 1.5.13 
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1.8 Scatter Chart 

In order to create a scatter chart click a “Scatter Chart” icon in “Dashboard Designer” 

window toolbar: 

 

An empty scatter chart will appear: 

 

A scatter chart contains the following fields: 

� “Х”-Axis - contains the data item against which the X-coordinates of data points are 

calculated; 

� “Y”-Axis - contains the data item against which the Y-coordinates of data points are 

calculated; 

� Weight - contains the data item whose values are used to calculate the weight of data 

points; 

� Argument - contains data items providing scatter chart arguments that are used to 

create data points. 
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Let us build a scatter that will display the values of the “Sales Amount” measure and “Gross 

Profit Margin” measure for product categories, and the size of the circle will correspond to the 

value of the “Gross Profit” measure. 

To do this, drag the “Sales Amount” measure to the “X”-axis, “Gross Profit Margin” 

measure to the “Y”-axis , “Gross Profit” to the “Weight” field, and drop the “Category” hierarchy 

into the argument: 

 

By default, a scatter chart does not contain the elements coloring. In order to color the 

elements, you need to select “Hue” from the drop-down list by right-clicking the “Category” 

hierarchy in the context menu: 
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As a result, a scatter chart will have the following view: 

 

Let us find out which subcategories of products of the “Bikes” category gave such a high 

profit. To do this, select the “Subcategory” hierarchy in the argument field, and enable the “Drill 

Down” in the “Data” tab: 

 

By clicking the “Bikes” product category, we will see the number of product subcategories 

that it includes, and the corresponding measures values for them: 
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Let us turn “Hue” on for subcategories as well: 

   

After that, a scatter chart will get back to its initial view. However, after clicking “Bikes” 

product category again, we will get the following view of a scatter chart: 
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To return to the previous detail level (drill up), use the Drill Up button (the  icon). 

 X/Y – Axis settings  1.8.1

In a Design tab, there are the following scatter chart parameters: 

 

� Rotate  - rotate at 90° 

� “Х”-Axis Settings 

� “Y”-Axis Settings 

Note: axis properties are described in more details in abstract 1.7.1 
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 Point Labels 1.8.2

In order to display points, values in a scatter chart, you need to click the following icon in 

“Design” tab in a toolbar: 

 

As a result, a form with the following parameters will appear: 

 

� Show point labels – to display or not to display labels; 

� Content – labels values 

• Argument – point labels show argument values; 

• Weight – point labels show the weight summary value; 

• Values – point labels show summary values from “X” and “Y”-axes; 

• Argument and weight - point labels show the argument value and the 

corresponding weight summary value; 

• Argument and values - point labels show argument values and corresponding 

summary values. 

� Overlapping mode 

• Hide overlapping labels – if two or more labels overlap, some of them are 

automatically hidden to avoid overlapping; 

• None - the overlapping resolving algorithm is disabled; 

• Reposition overlapping labels - the default algorithm to re-position point 

labels in a random way, and avoid overlapping labels. 

� Orientation: 

• Default – A point label is displayed in its default orientation; 

• Rotate to the Right – A point label is rotated 90 degrees clockwise; 

• Rotate to the Left - A point label is rotated 90 degrees counter clockwise. 
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� Position 

• Outside – labels are located inside a point; 

• Insite – labels are located outside a point. 

For a scatter chart, you can also change legend's location and redefine coloring for toolbar 

elements. This process is described in more details in abstracts 1.7.2 and 1.7.4. 

 Drill Down 1.8.3

For a Scatter Chart such functionality as “Drill Down” is also available. Its working 

principle is described in abstract 1.6.5. 

 Export 1.8.4

When it is necessary, you can print or export a Scatter Chart into PDF, Excel or an image.  

� Export To PDF 

While exporting, the following options are available: 

 

• Page Layout – specifies the page orientation used to export a Scatter Chart dashboard 

item; 

• Size – specifies the standard paper size; 

• Show Title – specifies whether or not to apply the dashboard item caption to the 

exported document title; 

• Title – specifies the title of the exported document; 

• Size Mode - specifies the export size mode for the Scatter Chart dashboard item; 

• Include Filters / Parameters – allows you to include master filter values / parameter 

values to the exported document; 

• Position – specifies the position of the master filter and parameter values in the 

exported document. 

 

� Export to Excel 
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See abstract 1.5.13 

� Export to Image 

See abstract 1.5.13 

1.9 Pies 

In order to create Pies, click the following icon in a dashboard designer window: 

 

Let us create pies that will display the gross profit margin by product categories. For this, let 

us move the “Gross Profit Margin” measure into a value field, and “Category” into an argument: 
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Now let us have a look how “Gross Profit Margin” measure value has changed through the 

years. For this, let us move “Calendar Year” into rows: 

 

If necessary, you can quickly swap the value of an argument and a row by using the 

following icon on the toolbar: 

 

 Layout 1.9.1

In a “Design” tab, you can define the way to display pies elements: 

 

� Auto Arrange – by default, the “Auto Arrange” option is enabled, which 

automatically resizes pies to fit within the dashboard item; 
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� Arrange in Columns – place the elements in the given number of columns: 
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� Arrange in Rows – place the elements in the given number of rows: 
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 Labels 1.9.2

Pies display “data labels” that contain descriptions for pie segments, and 

provide “tooltips” with additional information: 

 

 

In “Data Labels” and “Tooltips” drop-down lists, you can choose one of the ways to display 

data values: 

 

Let us display the value of “Gross Profit Margin” in the data signatures of our pies, while in 

the tooltips - the share value, and display the signatures to the pies itself: 

  

Pies will look the following: 
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 Data Labels Position 1.9.3

Data Labels Position may be as follows: 

 

 Style 1.9.4

Pie has two ways to display: 

 

 Edit Colors 1.9.5

Default colors can be edited if needed. This process is described in more details in abstract 

1.7.4. 

 Drill Down 1.9.6

Such a function as Drill Down is available for pies. Its working principle is described in 

abstract 8.6.5. 

 Export 1.9.7

If needed, pies can be exported into PDF, Excel or an image. It is described in more details 

in abstract 1.5.13 

1.10   Gauges 

In order to create a dashboard element called “Gauges” you need to click the following icon 

in a designer window toolbox of a dashboard: 
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Gauges is a kind of an indicator, which displays the following values: target, actual, delta 

value. 

Target is a gauges arrow, “Actual” is a gauges sign on the scales, “Delta” is an indicator sign 

on a gauges. 

Let us have a look at gauges that have “Reseller Sales Amount” measure as a target, and 

“Internet Sales Amount” as a actual, and analyze them in terms of product categories. For this, fill 

in the fields in the following way: 

  

As a result, we will get some gauges: 
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 Delta 1.10.1

By default, a gauge shown the difference between an actual and a target. This difference is 

called delta: 

 

In order to change delta settings you need to click the following icon: 

 

A form with the following indicator parameters will appear: 
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Value type: 

� Actual Value – value of an actual measure; 

� Absolute Variation  – difference between an actual and a target; 

� Percentage Variation – percent of difference between an actual and a target; 

� Percentage of Target – percent of an actual and a target. 

Result indication: 

� Greater is Good – The 'good' indication is displayed if the actual value exceeds the 

target value; if the target value exceeds the actual value, the 'bad' indication is 

displayed; 

� Less is Good – The 'bad' indication is displayed if the actual value exceeds the target 

value; if the target value exceeds the actual value, the 'good' indication is displayed; 

� Warning if Greater – A warning is displayed if the actual value exceeds the target 

value; otherwise, no indication is displayed; 

� Warning if Less – A warning is displayed if the target value exceeds the actual value; 

otherwise, no indication is displayed; 

� No Indication – Indication is not displayed.  

For the delta, you can set the threshold value, which will indicate the excess of the actual 

above the target. The threshold type can be percent or absolute. 

Let us display the percentage of difference between an actual and a target for our gauges. 

We are interested in those values for which the percentage of difference is greater than zero. For 

this, fill out the form as follows: 

 

As a result, we will get gauges of the following view: 
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 Gauge Scale 1.10.2

By default, the Gauge dashboard item automatically determines the range of the gauge 

scales based on the values they display. 

You can override this behavior and specify maximum and minimum values on the scale: 

 

 Layout 1.10.3

Different layout options are available for gauges. Principle and working method are 

described in abstract 1.9.1.  

 Style 1.10.4

The Gauge dashboard item allows you to select the gauge type: 

 

 Drill Down 1.10.5

Such a function ad “Drill Down” is available for indicators. Working principle of this 

functionality is described in abstract 1.6.5. 

 Export 1.10.6

You can print indicators as well as export them into PDF, Excel or an image. The ways are 

described in abstract 1.5.13. 
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1.11 Cards 

To create a “Cards” dashboard element, click the toolbar icon in the dashboard designer 

window: 

 

A “Cards” dashboard element is a series of cards, each of which displays the difference 

between two values (measures). 

Let's show the difference between the two measures “Reseller Sales Amount” and “Reseller 

Total Product Cost” for subcategories of products. For this, fill in the fields as follows: 

 

As a result, we received several cards that display: 
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 Delta 1.11.1

In order to set or change the delta value, you must click (the  icon): 

 

In the opened form “Card Settings” go to the “Delta Options” tab: 

 

Then, specify the following settings: 

� Result indication: 

• Greater is good – the 'good' indication is displayed if the actual value exceeds the 

target value; if the target value exceeds the actual value, the 'bad' indication displays 
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• Less is good – the 'bad' indication displays if the actual value exceeds the target 

value; if the target value exceeds the actual value, the 'good' indication displays 

 

• Warning if greater – a warning is displays only if the actual value exceeds the target 

value 

 

• Warning if less – a warning is displays only if the target value exceeds the actual 

value; otherwise, no indication is displayed 

 

• No Indication – indication is not displayed. 
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For the delta, you can set a threshold value, which will indicate an excess of an actual above 

a target. 

The threshold type can be percent or absolute. 

 Sparkline 1.11.2

Sparklines can be used to visualize the variation of actual or target values (for instance, over 

time). 

Let us analyze the change in actual value in terms of months of the year. For this, move the 

“Month of Year” hierarchy into the “Sparkline” field: 
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Sparkline itself has the following parameters: 

 

� Sparkline view type - defines the sparkline’s view type. Sparkline data points can be 

represented as area, line, bars, or win and loss squares. 

� Highlight min/max points - specifies whether to highlight the minimum/maximum 

points of a sparkline; 

� Highlight start/end points – 

 specifies whether to highlight the start/end points of a sparkline. 

 Card Layouts 1.11.3

To change a card's layout, click the “Options” button (the  icon) displayed next to the 

data item container in the Cards section: 
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In the form that opens, the following layouts are available on the “Layout Options” tab: 

 

� Stretched – the Stretched layout template arranges card elements so that they occupy 

an entire card area 
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� Centered – the Centered layout template is used to center card elements so that they 

occupy a specified width/height 

 

� Compact – the Compact layout template is used to arrange card elements so that they 

occupy the minimum area 

 

� Lightweight – the Lightweight layout template displays the minimum set of elements 
within a card 
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For all layout types, you can change the visibility of its elements, or you can specify the 

display value type for data-bound elements: 

 

On the “Layout Options” tab, select the required layout type in the “Select template” list and 

specify its settings: 

• Min width - specifies the minimum width of the card content; 
• Max width - specifies the maximum width of the card content. Use the “Auto” option to 

determine the maximum width automatically; 

You can show/hide the following values and visual elements within the card: 

� Actual Value – a summary value for a measure placed in the Actual placeholder; 

� Title – displays values of the last (bottommost) dimension placed in 

the Series section; 

� Subtitle – displays combined values of all dimensions except the last (bottommost) 

dimension; 

� Percent Variation – a percent difference between the actual and target value; 

� Absolute Variation – an absolute difference between the actual and target value; 

� Delta Indicator – indicates whether the actual value is less or greater than the target 

value 

� Sparkline – visualizes the variation of actual or target values. 
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 Format Options 1.11.4

The Card dashboard item formats the actual and target values displayed within cards 

using format settings specified for data items. Click the options buttons (the  icon) displayed 

next to the data item container in the Cards section to change format settings for other values: 

 

In the invoked “Card Settings” dialog, go to the “Format Options” tab and use the “Select 

value type” option to specify which values’ format settings should change: 

 

 Cards Arrangement 1.11.5

The following display methods are available for the cards in the “Design” tab: 

 

The principle of functionality is similar to that of Pies – abstract 1.9.1 

 Drill Down 1.11.6

Such a function as Drill Down is available for Cards. The principle of this functional is 

described in abstract 1.6.5. 
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 Export 1.11.7

Cards may be exported into PDF, Excel or an image. Ways to do this are described in 

abstract 1.5.13 

1.12  Treemap 

To create a Treemap, click the corresponding icon on the toolbar: 

 

Let us display the volume of sales by product categories. Having filled in the fields as in the 

picture below, we get a treemap of the following view: 
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Now add a “Subcategory” hierarchy into an “Argument” fields: 

 

Let us group the subcategories of one group of products: 
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As a result, a Treemap will look as follows: 

 

 Layout 1.12.1

The following methods of displaying Treemap tiles are available on the “Design” tab: 

 

� Slice and Dice - this layout algorithm divides the space between items, slicing it in the 

specified direction depending on item value; 

� Squarified - the Squarified algorithm arranges tiles so that their width/height ratio will be 

closer to 1; 

� Striped - this algorithm is a modified version of the Squarified algorithm. The difference 

here is that tiles are drawn side by side as columns or rows; 



85 
 

� Layout Direction - you can also set a layout direction to specify an arrangement of tiles 

depending on their sizes: 

 

 Labels 1.12.2

There are two types of labels in a Treemap: 

� Tiles Labels 

� Group Labels 

 

The Treemap displays labels that contain descriptions for tiles and groups, and provide 

tooltips with additional information: 
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Use buttons within the “Tile Labels” / “Group Labels” ribbon groups to manage tile and 

group labels, respectively. These buttons invoke the drop-down menu, which is similar for all 

buttons: 

 

 Edit Colors 1.12.3

For a treemap the Color Editor functionality is available. The principle of its functionality is 

described in abstract 1.7.4. 

 Export 1.12.4

Treemap may be exported into PDF, Excel or an image. The ways to do this are described in 

abstract 1.5.13 

1.13  Filter Elements 

Filter elements represent a special type of dashboard item that allows you to apply filtering 

to other dashboard items. 

To create a Filter dashboard element, click the icon: 

 

The following filters are available in the drop-down list: 

 

� Combo Box - the Combo Box dashboard item allows to select a value(s) from the 

drop-down list. 
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On the “Design” tab for this filter, there are two ways to select values: 

 

• Standard – allows to select only a single value: 

 

• Checked - allows to select multiple values in the invoked drop-down list: 

 

� List Box - the List Box dashboard item allows to select a value(s) from the list 
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On the “Design” tab for this filter, there are two ways to select values: 

 

• Checked – allows to select multiple values in the list box 

 

• Radio - allows to select only a single value in the radio group 

 

In addition, there is a possibility to enable filtering for all elements: 
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� Tree View - the “Tree View” dashboard item displays values in a hierarchical way 

and allows to expand/collapse nodes 

 

You can manage the initial expanded state of filter values using the “Auto Expand” button in 

the “Design” ribbon tab: 

 

Auto Expansion - the tree will be in the expanded state. 

For all types of filter available quick search: 
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1.14  Range Filter 

The “Range Filter” dashboard element as well as “Filtr” allows to apply filtering to other 

dashboard elements. 

 

This element displays a chart with selection thumbs that allow you to filter out values 

displayed along the argument axis: 
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This filter can be used for cross-filter data sources. For this, use the “Cross-Data-Source-

Filters” button on the “Data” tab: 

 

You also can not apply end-to-end filters to this element: 

 

You can create your own ranges of data. To do this, use either the context menu (right 

mouse button) or click on the  icon in the “Argument” field: 

 

As a result, the “Edit Periods” window appears: 
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The list on the left shows the list of ready periods that you can filter: 
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In order to add the selected period, use the  button or simply drag the period in the field 

on the right: 

 

This period will be added to the right pane of the Edit Periods dialog. The following settings 

are available for the added period: 

• Caption – title name for the period; 

• Period - displays the time interval of the date corresponding to the period; 

• Default - allows to use the selected period as the default value in the element of the Range 

Filter panel. 

 

You can create your own period. To do this, use the “Add Custom Period ...” button in the 

“Edit Periods” window: 
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As a result, a window appears in which you can add the following periods: 

 

For the year, quarter and month it is possible to set to display: 

• Previous Year/Quarter/Month; 

• This Year/Quarter/Month; 

• Next Year/Quarter/Month; 

• Last Year/Quarter/Month; 

• Next Year/Quarter/Month. 
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There is also a possibility to create a Custom period: 

 

This period allows to specify a period with user boundaries (“Start” and “End” point): 

 

For start and end points, you can set the following parameters: 
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• None – the start and end points will be equal to the start and end values from the 

visible range; 

• Fixed – possibility to select a specific value in the calendar; 

• Flow – allows to specify a floating period with interval and offset. “Interval” - 

indicates the interval between the current date and the required date, “Offset” - the 

number of such intervals: 
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1.15 Group 

The “Group” dashboard element allows you to merge several elements into a single group. 

To create a Group element, click the icon: 

 

Let us have a look at the working principle of this element on the example of two groups. 

First, we create two elements of the dashboard - a chart (of a “Spline Area” type) and a filter 

(of a “Tree View” type). For each of them, fill in fields with appropriate data: 
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Now create the first group (click the icon of the same name in the toolbar) and drag the chart 

and filter into it: 

 

Thus, we got a group, elements of which can interact with each other within this group and 

outside it. 

On the “Data” tab: 

 

� The “Master Filter” button allows you to specify whether the current group allows 

you to filter external dashboard items using master filter items contained within the 

group. If this option is disabled, master filter items contained within the group can 

filter only dashboard items from this group; 

� The “Ignore Master Filters” button allows you to isolate dashboard items contained 

within the group from being filtered using external master filter items. 

For the first group, let us leave the filter on – “Ignore Master filters”. 
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Now let us create the second group. It will consist of a chart and two filters (“List Box” and 

“Combo Box”): 

 

We paint subcategories of the same groups of products in the same color: 

 

Now let us create a filter – “Combo box”: 
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The second filter will be called “List Box”: 

 

For a “List Box” on the “Data” tab disable “Ignore Master Filters” button: 

 

Create a second group and drag the chart and filters into it: 

 

For this group on the “Data” tab, we also leave an active “Ignore Master Filters” filter. 
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Thus, we got two independent groups: 
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The first shows the sales volume of the groups of products depending on the month of the 

year and country, and the second shows the sales volume of a particular group of products by 

subcategories: 
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1.16 Images 

An image can be one of the elements of a dashboard. To add an image, click the 

corresponding icon in the toolbar: 

 

An «Interactive Dashboard» allows to create two types of image elements: 

 

� Image 

� Bound Image 

 Image 1.16.1

To add an “Image” element, choose the following sub-item: 

 

An empty field appears in the dashboard designer window: 
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Now, to add an image, go to the “Design” tab and click an “Import Image” icon: 

 

In the opened form, specify the location of the file and click an «OK» button. As a result, the 

dashboard will look the following: 

 

If necessary, the size and location of the image can be changed: 

 

An image may be exported into PDF or an image. The ways to this are described in abstract 

1.5.13. 
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 Bound Image 1.16.2

To add a “Bound Images” item, select the following sub-item: 

 

A new element appears in the designer window: 

 

Next, you need to choose how to bind the data to the image by clicking the  

“Options”  button next to an attribute. The following options will be available in the 

opened window: 

 

� Binary Array – use this mode if images are stored in the data source as byte arrays; 
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� URI – use this mode to locate images accessible by a predefined URI. In this case, 

the data source field should return strings that are parts of URIs to these images. 

For instance, the URI pattern in the form below specifies the path to the folder containing 

the required images: 

 

Data source field values will be inserted to the position of the {0} placeholder. Thus, the 

Bound Image maps the current dimension value with the image placed at the specified URI. 

 

For example, let us display flags for each country for the following table: 
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To start with, we will place the files with the corresponding image and name in the folder: 

 

We will create a new “Bound Images” element with the “Country” attribute: 
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The form of data binding will be filled with the following data: 

 

Now, all is left is to insert the data source field values into the {0} placeholder position: 
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As a result, we will get an interactive dashboard in which the table with the “Country” 

hierarchy will be linked to the image: 

 

1.17  Text Box 

“Text Box” can be one of the elements of the dashboard. Click the corresponding icon on 

the toolbar: 

 

In the designer window, an empty text field appears: 

 

To insert or edit text, go to the “Design” menu tab and click an “Edit” icon: 
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Or use the corresponding item in the context menu: 

 

The text editing form with the following set of tools will appear: 

 

The Text can be exported into PDF or an image. 
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The “Text” element can be bound to the data of other dashboard elements. Let us add a 

“Text” element to the dashboard, and let’s alternately drop the following values of “Product”, “Unit 

Price” and “Description” in the value field: 

 

Now move to the “Design” tab and click an “Edit” button: 

 

In the text field, insert the following data: 
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Then place the cursor at the end of the “Name” text and right-click on it. Select “Insert 

Field” from the context menu: 

 

Now click on the “Select value” field and select the “Product” value: 

 

Repeat the same steps for the “Price” and “Description” fields: 
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Now click on the “Edit” button again to exit the edit mode. The following data will be 

displayed in the “Text Box”: 

 

Let's use filters to make the “Text Box” field more dynamic. Add two filters of the List type 

with the following fields to the dashboard: 
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And, finally let’s add the “Images” element with the data binding and we throw the 

“LargePhoto” in the value field: 
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1.18 Conditional Formatting 

For “Grid” and “Pivot” dashboard elements, it is possible to set the format rules. 

You can create a new format rule in two ways: 

Way 1. Click an “Option” button next to the appropriate dimension/measure: 

 

 

Way 2. Right-click on the table header: 
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 Format Rule: Value 1.18.1

Value can be one of the highlight rules: 

 
Let us have a look at it on an example of the pivot table: 

 



117 
 

Let us select the totals of those product categories for which the values of the “Sales 

Amount” measure are more than $ 1 million: 

 

The following form appears: 

 

This form contains the following parameters specific to Pivot: 
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� Format values that are greater than… – set value; 

� Appearance/Icons – the “Appearance” tab allows you to choose the predefined 

background color/font, the “Icons” tab allows you to add the predefined icon; 

� Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

• Auto – identifies the default level. For the Pivot dashboard 

item, auto identifies the “First Level”; 

• First level – first level values are used to apply conditional formatting; 

• Last level – the last level values are used to apply conditional formatting; 

• All levels – all pivot data cells are used to apply conditional formatting; 

• Specific level – values from the specific level are used to apply conditional 

formatting. 

� Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

� Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

� Apply to row/column – apply to the entire row / to the entire column. 

Fill out this form as follows: 

 

As a result, the “Pivot” table will look the following: 
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To edit an existing highlight rule, click the “Options” icon next to the measure: 
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In the window that appears, double-click the rule or click an “Edit” button: 

 

To delete the format rule, select the necessary format rule in the list in the “Edit Rules” 

window and click the “Delete” button:  
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If necessary, the rule can be temporarily disabled by unchecking the corresponding rule: 

 

 Format Rule: Top N / Bottom N  1.18.2

The “Top-Bottom” format conditions allow you to highlight a specific number of 

topmost/bottommost values. You can specify this number as an absolute or percent value: 
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For example, let us select 4 quarters for which the “Sales Amount” measure values were the 

worst. Select the type of “Bottom N” highlight and fill out the form as follows: 
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Pivot will look like this: 
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Now let us check those product categories, the profit from which amounted to 90% of the 

total profit. For this, select the “Top N” highlight type and fill out the form as follows: 
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We get the following Pivot: 

 

Two product categories – “Bikes” and “Components” - gave 90% out of all profits. 

 Format Rule: Average 1.18.3

The “Average” format conditions allow you to highlight values above or below an average 

value: 
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 Format Rule: Expression 1.18.4

An “Expression” format condition allows you to use complex conditions to apply 

formatting:  
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 Format Rule: Icon Ranges 1.18.5

Icon “Ranges” allow you to use predefined or custom sets of icons to apply conditional 

formatting to different ranges of values: 

 
For example, let us select the 4-range highlight for the “Gross Profit” measure: 
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The following options are available in the appeared window: 

 

� Format style – the “Format Style” combo box allows you to change the icon set used 

to apply formatting; 

� Use % ranges - the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 

� Range field with set values: 
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Use the «Add» and «Delete» buttons to add new ranges or delete the selected range 

respectively. Note that new range is added below the selected range: 

 

To change the icon displayed for values corresponding to the specified range, click the 

button next to the required icon and select a new icon: 

 

� Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

• Auto –  identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

• First level – first level values are used to apply conditional formatting; 

• Last level –  the last level values are used to apply conditional formatting; 

• All levels – all pivot data cells are used to apply conditional formatting; 

• Specific level – values from the specific level are used to apply conditional 

formatting. 

� Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

� Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

� Apply to row/column – apply to the entire row / to the entire column. 

 



130 
 

Fill in the form with the following data:: 
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As a result, the pivot table will look the following: 

 

 Format Rule: Color Ranges 1.18.6

To format values according to the required condition, click the data item menu button, select 

“Add Format Rule”| “Color Ranges” and choose the required color set: 
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The working principle is the same as for the “Format Rule: Icon Ranges” highlight rule 

(abstract 8.18.5): 

 



133 
 

 Format Rule: Gradient Ranges 1.18.7

“Gradient Ranges” allow you to use predefined color gradients to apply conditional 

formatting to different ranges of values. You can also use specific colors to generate custom 

gradients.: 
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The form of the gradient highlight looks the following 

 

The following options will be available in the appeared window: 

� Number of ranges – “Number of ranges” allows you to specify the number of ranges 

used to classify values. Click the “Generate Ranges” button to generate a new 

gradient scale according to the specified number of ranges; 

� Use % ranges - the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 
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� Range field with specified ranges: 

 

� Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

• Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

• First level – first level values are used to apply conditional formatting; 

• Last level – the last level values are used to apply conditional formatting; 

• All levels – all pivot data cells are used to apply conditional formatting; 

• Specific level – values from the specific level are used to apply conditional 

formatting. 

� Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

� Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

� Apply to row/column – apply to the entire row / to the entire column. 
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 Format Rule: Bar 1.18.8

The “Bar” format condition allows you to visualize numeric values using bars. You can also 

paint bars corresponding to positive and negative values using different colors: 

 

This dialog allows you to change the following options specific to the “Bar” format 

condition: 
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� Min/Max – by default, lengths of the shortest and longest bars correspond to 

minimum and maximum values, respectively. If necessary, you can specify values 

corresponding to the shortest and longest bars manually. To do this, change the type 

of minimum/maximum value from “Automatic” to “Number or Percent”, and specify 

the required values; 

� Style Settings – “Style Settings” and “Negative Style Settings” allow you to specify 

style settings used to color data bars corresponding to positive and negative values, 

respectively; 

� Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

• Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

• First level – first level values are used to apply conditional formatting; 

• Last level – the last level values are used to apply conditional formatting; 

• All levels – all pivot data cells are used to apply conditional formatting; 

• Specific level – values from the specific level are used to apply conditional 

formatting. 

� Row/Column dimension - if you specified the Intersection mode as Specific Level, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

� Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

� Apply to row/column – apply to the entire row / to the entire column; 

� Allow negative axis – the “Allow negative axis” option allows you to specify 

whether negative data bars are displayed in the direction opposite to the positive data 

bars; 

� Draw axis – the “Draw axis” option specifies whether to draw the vertical axis 

between positive and negative data bars; 

� Show bar only – the “Show bar only” option specifies whether to show bars without 

corresponding values. 

Let us look at this type of highlight on the example of the “Pivot” table: 
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Let us add a highlight rule for the “Reseller Gross Profit” measure: 
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Fill out the form as follows: 
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As a result, we will get the following table: 

 

 Format Rule: Bar Color Range 1.18.9

“Bar Color Ranges” allow you to visualize numeric values using bars whose colors are 

contained in the specified color set: 
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This dialog allows you to change the following options specific to “Bar Color Ranges”: 

 

The following options will be available in the appeared window: 

� Format style – the “Format Style” combo box allows you to change the color set 

used to apply formatting; 

� Use % ranges - the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 
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� Range field with specifies values: 

 

Use the «Add» and «Delete» buttons to add new ranges or delete the selected range 

respectively. Note that new range is added below the selected range: 

 

To change the icon displayed for values corresponding to the specified range, click the 

button next to the required icon and select a new icon: 

 

� Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

• Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

• First level – first level values are used to apply conditional formatting; 

• Last level – the last level values are used to apply conditional formatting; 

• All levels – all pivot data cells are used to apply conditional formatting; 
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• Specific level – values from the specific level are used to apply conditional 

formatting. 

� Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

� Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

� Apply to row/column – apply to the entire row / to the entire column; 

� Allow negative axis – the “Allow negative axis” option allows you to specify 

whether negative data bars are displayed in the direction opposite to the positive data 

bars; 

� Draw axis – the “Draw axis” option specifies whether to draw the vertical axis 

between positive and negative data bars; 

� Show bar only – the “Show bar” only option specifies whether to show bars without 

corresponding values. 

 Format Rule: Bar Gradient Ranges 1.18.10

Bar Gradient Ranges allow you to visualize numeric values using bars whose colors are 

contained in the specified color gradient: 
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This dialog allows you to change the following options specific to “Bar Gradient Ranges”: 

 

� Number of ranges – “Number of ranges” allows you to specify the number of ranges 

used to classify values. Click the Generate Ranges button to generate a new gradient 

scale according to the specified number of ranges; 

� Use % ranges - the “Use % ranges” check box specifies whether the percent or 

absolute scale is used to generate ranges; 
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� Range field with specified values: 

 

 

� Intersection mode – the level at which the highlight will be applied. The levels can 

be as follows: 

• Auto – identifies the default level. For the Pivot dashboard 

item, Auto identifies the “First Level”; 

• First level – first level values are used to apply conditional formatting; 

• Last level – the last level values are used to apply conditional formatting; 

• All levels – all pivot data cells are used to apply conditional formatting; 

• Specific level – values from the specific level are used to apply conditional 

formatting. 

� Row/Column dimension - if you specified the Intersection mode as “Specific Level”, 

use the “Row dimension” and “Column dimension” combo boxes to set the specific 

level; 

� Apply to – to which element (measure, hierarchy) of the Pivot table the conditional 

formatting should be applied; 

� Apply to row/column – apply to the entire row / to the entire column; 

� Allow negative axis – the “Allow negative axis” option allows you to specify 

whether negative data bars are displayed in the direction opposite to the positive data 

bars; 

� Draw axis – the “Draw axis” option specifies whether to draw the vertical axis 

between positive and negative data bars; 

� Show bar only – the “Show bar” only option specifies whether to show bars without 

corresponding values. 
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1.19 Top N 

The “Top N” feature allows you to display only a limited number of values that correspond 

to the highest or lowest values of a particular measure 

Let us consider the working principle of the given functionality on an example of a grid (the 

highlight rule - line color range): 

 



147 
 

We display only 7 subcategories with the best values of “Order Count” measure: 

 

The following parameters are available in the form: 

 

� Enabled – enables/disables this functionality; 

� Mode – specifies whether top or bottom values should be displayed; 

� Count – the number of values to be displayed; 

� Measure – the parameter according to which the top or bottom values will be 

determined. 
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Fill out the form as follows: 

 

As a result, the table looks the following: 
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And now let us add the “Category” dimension to the columns and we get the following 

result: 

 

Now we have 7 best “Order Count” measure indicators for each product category. 
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1.20 Sorting 

Let us sort the table obtained earlier in the decreasing order of the “Order Count” measure. 

For this, click in the right corner of the table next to an icon: 

 

The column with the Order Count measure is sorted in a descending order: 

 

Having clicked again, we get the opposite result (an increase of the “Order Count” measure). 
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To sort the hierarchy alphabetically, you need to open the context menu: 

 

By selecting the “Sort Descending” method, we get a table with category names sorted in a 

descending order: 
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If necessary, you can disable sorting: 

 

OLAP Sorting specific: 

 

� (Value) – sorting is performed by member values; 

� (Display Text) – sorting is performed by captions associated with members; 

� (Key) – sorting is performed by member keys; 

� (ID) – sorting is performed by member IDs. 

1.21 Formatting Data 

 Formatting Numeric Values 1.21.1

You can change the data format. This functionality is available on the “Dashboard Designer 

toolbar”: 
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To specify a format for numeric values, select “Format” from the data item menu: 

 

This invokes the “Numeric Format” window: 

 



154 
 

Types of formats can be as follows: 

 

Other format settings are in effect for only specific format types: 

� Unit – the unit to which values should be converted; 

� Precision – the number of fractional digits that should be displayed; 

� Currency – defines the currency sign and format settings that should be used to 

display currency values; 

� Culture – for currencies used in a region with several cultures, specifies the culture 

that defines format settings 

� Include group separator – specifies whether or not separators should be inserted 

between digit groups. 
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 Formatting Date-Time Values 1.21.2

For date and time values, this functionality has the following parameters: 

 

 Currency Formatting Specifics 1.21.3

The «Interactive dashboard» allows you to specify a currency format at two levels: for the 

entire dashboard and for individual data items: 

� Data Item Currency – to specify which currency to use for a particular data item, 

select “Format” from the data item menu: 

 

In the “Numeric Format” dialog, select “Currency” in the “Format type” field and use 

the “Currency” combo box to select the required currency: 
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For regions with several cultures, you can also select the culture that will be used to format 

currency values: 
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You can also apply the default dashboard currency by selecting «Use dashboard settings» in 

the “Currency” field: 

 

� Dashboard Currency 

You can also specify the default currency for the dashboard. This setting will be applied to 

dashboard items that have no currency defined. 

To set the dashboard currency, click the “Currency” button on the toolbar: 

 

This invokes the Dashboard Currency window. In this window, select the required currency 

using the “Currency” combo box: 
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1.22 Parameters 

The parameter is a dashboard element that allows to dynamically influence the “Expression” 

highlight rule. 

In order to create a parameter, click the toolbar icon: 

 

The following window opens: 
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To add the parameter, click the «Add» button. The following parameters are displayed in the 

window: 

 

� Visible – specifies whether or not the parameter editor is visible in the dashboard 

Parameters dialog; 

� Allow Null –specifies whether or a not null value can be passed as a parameter value;  

� Allow Multiselect – specifies whether or not multi-selection is enabled for the current 

parameter. The following limitations are applied to parameters with multi-selection enabled. 

• Use the “is any of” or “is none of” operators to pass a multi-select parameter to 

a filter criteria or to the Expression format condition. 

• Use the “In” or “Not In” operators to pass a multi-select parameter to a calculated 

field expression. 

• Custom SQL queries do not support multi-select parameters. 

• Stored procedures used in SQL and Entity Framework data sources do not support 

multi-select parameters. 

� Description – specifies the parameter's description displayed; 

� Look-Up Settings – specifies the parameter's look-up editor settings; 

� Type – specifies the parameter type; 

� Value – specifies the default parameter’s value(s). 

Note that when “Allow Multiselect” is set to “true”, the “Value” option allows you to select 

multiple parameter values; 

� Name – Specifies the parameter name. 

• A name can contain letters, numbers and underscores. 

• A name cannot contain spaces. 

• A name cannot be an empty string. 

• The dashboard cannot contain parameters with the same name. 
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• Names are case-sensitive. For example, you can create the 

names Parameter and PARAMETER. 

 

Let us create a setting that highlights the “Reseller Sales Amount” value of more than 

$500,000, but less than $ 1 million for all product subcategories. 

First, we add a table with the following values: 
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Create two parameters and fill in the fields as follows:  
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For “Reseller Sales Amount”, create an “Expression” highlight rule with the following 

parameters: 

 

As a result, the first parameter from the list is displayed in the value field: 
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Similarly, double-click the second value field: 

 

The first parameter will be displayed again, click it and select the “Sales2” parameter in the 

opened list: 
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It is only left to choose the color of highlight on the panel: 
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Now all the values of the “Reseller Sales Amount” measure that are higher than $ 500 000 

but lower than $ 1 million for all product subcategories are highlighted in the table: 

 

Now let us change the range of values: Sales1 = $ 200 000, and Sales2 = $ 2 million. 
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For this, click the “Options” icon in the toolbar: 

 

In the opened window enter the corresponding values for each parameter: 
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As a result, we get a table where all the values of “Reseller Sales Amount” measure for more 

than $ 200 000 but less than $ 1 million are highlighted: 
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1.23 Hidden data items 

Each dashboard element in the “Data Items” field contains an additional 

field – “Hidden Data Items”: 

 

Elements of this field can be used as a context. 

Let us consider it on an example of one of the previous tables: 

 



169 
 

We display the 7 best values of the “Order Count” measure for each product category only 

for year 2018. For this, drop the “Calendar Year” hierarchy into the “Hidden Data Items” field: 

 

Now, from the context menu (by a right-click), select “Edit Filter” icon: 

 

In the drop-down list, select the “Calendar Year” hierarchy: 
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And then specify the year: 
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Now the table displays the 7 best values of the “Order Count” measure for each product 

category for year 2018 only: 
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1.24 Aggregations 

In the interactive dashboard, the following aggregate functions are available: 

 

• Count – returns the number of values 

•  Count Distinct – returns the number of distinct values 

•  Sum – returns the sum of all values 

• Min – returns the minimum value across all records 

• Max – returns the maximum value across all records 

• Average - Returns the average of all the values in the expression. 

• StdDev - Mean Square Deviation 

• StdDev P - dispersion 

• Var - Non-shifted dispersion 

• VarP – median 

• Mode 
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1.25 Calculated Members 

The «Interactive Dashboard» allows to add the following calculated elements based on the 

ready-made measures: 

 

• Percent of Column Grand Total 

• Percent of Row Grand Total 

• Percent of Grand Total 

• Running Summary along Columns 

• Running Summary along Rows 

• Difference along Columns 

• Difference along Rows 

• Percentage Difference along Columns 

• Percentage Difference along Rows 

• Rank along Columns 
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• Rank along Rows 

• Rank along Cells 

You can create your own computational element: 
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As a result, “Customize Calculation” form appears: 

 

 Running Total 1.25.1

The “Running Total” calculation can be used to compute a cumulative total for the  

specified measure: 

 

• Running along – the direction that is used to calculate running totals; 

• Summary function – specifies a summary function used to apply calculation. 



176 
 

 

 In the table below, we can see sub-total sales for all months: 

 

 Moving Calculation 1.25.2

The “Moving calculation” uses neighboring values to calculate a total: 

 

• Moving along – specifies a window and direction used to apply a calculation; 

• Summary function – specifies a summary function used to apply calculation. 
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Start/End offset - initial and final offsets from the current value in process: 

  

In the table below, we can see the moving average for all months with an initial offset of -2 

and a final offset of 0: 

 

 Difference 1.25.3

The “Difference” calculation can be used to compute the difference between measure 

values: 

 

• Calculate along – specifies a window and direction used to calculate differences; 

• Difference from – select value 

� Previous 

� Next 

� First 
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� Last 

• Percentage Difference – show the percentage difference. 

 

In the table below, we can see an absolute value of the difference between the months 

(Difference from - Previous): 

 

 Percent Of Total 1.25.4

A calculation is used to compute a percentage of the total for the specified measure: 

 

• Percent of total - specifies a window and direction used to apply a Percent of Total 

calculation. 
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Below we can see the table that displays the contribution of individual monthly sales to total 

sales: 

 

 Rank 1.25.5

Use the “Rank” calculation to compute rankings for the specified measure: 

 

• Rank along – specifies a window and direction used to rank values; 

• Rank type 

� Unique 

� Competition 

� Dense 

� Modified 

� Percentile 

• Order - ranking order 
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� Ascending 

� Descending 

 

Below we can see the table that displays the ranking of sales for particular years in 

descending order:  

 

 Expression 1.25.6

With such choice, you can create your own expression using the necessary functions. 

To do this, click the “Edit in Expression Editor” button: 
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In the window that appears, write the appropriate expression: 
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1.26 Interactive Dashboard Filtering 

The «Interactive Dashboard» allows you to use any data aware dashboard item as a filter for 

other dashboard items: 

 

To reset filtering, use the “Clear Master Filter” button (the  icon). 

You can prevent specific dashboard items from being affected by “Master Filters”. To do 

this, use the “Ignore Master Filters” button: 
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1.27 Dashboard Title 

The “Dashboard Title” is located at the top of the dashboard surface. It can contain text or 

image content: 

 

You can change title settings by clicking the “Title” button: 
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This dialog allows you to specify the following options: 

 

� Visible – specifies whether or not the dashboard title is visible; 

� Show Master Filter state – specifies whether or not to show the state of master filter 

items in the dashboard title; 

� Text – title text; 

� Alignment – specifies the alignment of the dashboard title; 

� Images – allows you to specify the image displayed within the dashboard title; 

When you hover over the filter icon ( ), all master filters applied to the dashboard are 

displayed in the invoked popup: 
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1.28 Dashboard Item Caption 

The title of the dashboard element is located at the top of the dashboard and contains the 

following information: 

 

To edit the title of the dashboard element, select the Edit names item in the context menu of 

the element: 
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1.29 Dashboard Items Layout 

The “Dashboard Designer” provides the capability to arrange and resize dashboard items 

and groups in various ways, using simple drag-and-drop operations: 
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You can change the position of a dashboard item by using drag-and-drop: 

 

1.30 Undo and Redo Operations 

In the «Interactive Dashboard» it is possible to undo and redo the actions performed on the 

dashboard. To undo/redo the last action, use the following buttons: 

 

To undo/redo several actions at once, click the arrow next to “Undo” / “Redo” button and 

select the actions in the list that you want to undo/redo 
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1.31 Automatic and Manual Updates 

The option “Automatic” is available on the toolbar of the «Interactive Dashboard»: 

 

If this option is enabled, then all changes to the page structure will immediately display 

updated data. If this option is disabled, you can first modify the page as you like, and then click the 

button on the Button toolbar to send a request to the server for data: 
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1.32 Interactive shared dashboards 

After you created a number of dashboards, you can share them. To do this, right-click on the 

name of the dashboard and select an appropriate menu item: 

 

After that, other users and administrator will see your page in the list of shared dashboards. 

 


